
Chapter 1

Access 2013 Basic Training

In This Chapter
▶ Deciding when to use Access

▶ Discovering what’s new in Access 2013

▶ Unlocking the basics of working with Access

▶ Figuring out how to get started

Access 2013, the most recent version of the Microsoft Office database 
application, continues to be a very powerful program. You probably 

already know that, and perhaps that power — or your perceptions of all that 
Access can do — is what made you reach for this book. We congratulate you 
on your wise choice!

For all of its power, Access is also very — pardon the expression — accessible. 
It’s pretty easy to use at the edges, where a new user will be; you don’t have 
to venture all the way in to its core to get quite a lot out of the software. In 
fact, with just the basic functionality that you’ll discover in this book, you’ll 
be able to put Access through many of its most important paces, yet you’ll 
be working with wizards and other onscreen tools that keep you at a com-
fortable arm’s distance from the software’s inner workings, the things that 
programmers and serious developers play with. There. Don’t you feel better 
now?

 You don’t have to use every feature and tool and push the edges of the Access 
envelope. In fact, you can use very little of everything Access has to offer and 
still create quite a significant solution to your needs for storing and accessing 
data — all because Access can really “do it all” — enabling you to set up a 
database quickly, build records into that database, and then use that data in 
several useful ways. Later on, who knows? You may become an Access guru.

In this chapter, you’ll discover what Access does best (and when you might 
want to use another tool instead), and you’ll get a look at what’s new and 
improved in Access 2013 (compared to Access 2010). You’ll see how it does 
what it does, and hopefully you’ll begin to understand and absorb some basic 
terminology.
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12 Part I: Getting Started with Access 2013 

Now, don’t panic; nobody’s expecting you to memorize tons of complex 
vocabulary or anything scary like that. The goal here (and in the next two 
chapters) with regard to terms is to introduce you to some basic words and 
general concepts intended to help you make better use of Access — as well 
as better understand later chapters in this book, if you choose to follow us all 
the way to its stunning, life-altering conclusion.

What Is Access Good For, Anyway?
What is Access good for? That’s a good question. Well, the list of what you 
can do with it is a lot longer than the list of what you can’t do with it — of 
course, especially if you leave things like “wash your car” and “put away the 
dishes” off the “can’t do” list. When it comes to data organization, storage, 
and retrieval, Access is at the head of the class.

Building big databases
Okay, what do I mean by big database? Any database with a lot of records — 
and by a lot, I mean hundreds. At least. And certainly if you have thousands 
of records, you need a tool like Access to manage them. Although you can 
use Microsoft Excel to store lists of records, it limits how many you can store 
(no more than the number of rows in a single worksheet). In addition, you 
can’t use Excel to set up anything beyond a simple list that can be sorted and 
filtered. So anything with a lot of records and complex data is best done in 
Access.

Some reasons why Access handles big databases well:

 ✓ Typically, a big database has big data-entry needs. Access offers not 
only forms but also features that can create a quick form through which 
someone can enter all those records. This can make data entry easier 
and faster and can reduce the margin of error significantly. (Check out 
Chapter 7 for more about building forms.)

 ✓ When you have lots and lots of records, you also have lots of opportuni-
ties for errors to creep — duplicate records, records with misspellings, 
records with missing information — and that’s just for openers. So you 
need an application such as Access to ferret out those errors and fix 
them. (Chapter 9 lays out how you can use Access to find and replace 
errors and search for duplicate entries.)

 ✓ Big databases mean big needs for accurate, insightful reporting. Access 
has powerful reporting tools you can use to create printed and onscreen 
reports — and those can include as few or as many pieces of your data 
as you need, drawn from more than one table if need be. You can tailor 
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13 Chapter 1: Access 2013 Basic Training

your reports to your audience, from what’s shown on the reports pages 
to the colors and fonts used.

 ✓ Big databases are hard to wade through when you want to find some-
thing. Access provides several tools for sorting, searching, and creating 
your own specialized tools (known as queries) for finding the elusive 
single record or group of records you need.

 ✓ Access saves time by giving you new uses for existing tools you may 
have used to import data from other sources — such as Excel work-
sheets (if you started in Excel and maxed out its usefulness as a data-
storage device) and Word tables. This saves you from reentering all 
your data and allows you to keep multiple data sources consistent.

Building apps
There are several ways to build apps — a term that’s come to mean an appli-
cation that runs on a smartphone or other hand-held device — but that also 
applies to SharePoint, with Access 2013.

You can build an app using the Access 2013 Web App template or build a 
custom web app, starting from scratch. You can also download an app from 
the Office Store and then customize it. You can also build a standard data-
base, just like you always have in Access, and publish that via the web.

Now, that said, this is not a book about apps or building them. The goal of 
this book is to show you how to use Access to build databases for use on a 
computer (a desktop or laptop/notebook). If you need to create a database 
app for use on a smartphone or tablet, you can check out any of the following 
publications or explore instructions available online by Googling How do I 
create a database app with Access 2013?.

You can also take a look at Dummies.com or check out iOS 6 Application 
Development For Dummies.

Creating databases with multiple tables
Whether your database holds 100 records or 100,000 records (or more), if 
you need to keep separate tables and relate them for maximum use of the 
information, you need a relational database — and that’s Access. How do you 
know whether your data needs to be in separate tables? Think about your 
data — is it very compartmentalized? Does it go off on tangents? Consider the 
following example and apply the concepts to your data and see if you need 
multiple tables for your database.
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The Big Organization database
A large company has data on their customers and their orders, the products 
the company sells, its suppliers, and its employees. For a complex database 
like this one, you need multiple tables, as follows:

 ✓ One table houses the customer data — names, addresses, phone numbers, 
and e-mail addresses.

 ✓ A second table contains the customers’ orders, including the name of 
the customer who placed the order, the salesperson who handled the 
sale, shipping information, and the date of the order.

 ✓ A third table contains information on the products the company sells, 
including product numbers, supplier names, prices, and the number of 
items in stock. 

 ✓ A fourth table contains supplier data — about the companies from which 
the main organization obtains its inventory of products to resell to cus-
tomers. The table contains the company names, their contact person, and 
the address, e-mail, and phone number information to reach them.

 ✓ A fifth table contains employee data — from the date they were hired 
to their contact information to their job title — and also contains notes 
about them, sort of a summary of their resumes for reference.

Other tables exist, too — to keep a list of shipping companies and their con-
tact information (for shipping customer orders), an expense table (for the 
expenses incurred in running the business), and other tables that are used 
with the main four tables. The need for and ways to use the main tables and 
these additional tables are covered later in this book, as you find out how to 
set up tools for data entry, look up records, and create reports that provide 
varying levels of detail on all the data you’ve stored.

 Because you don’t have to fill in every field for each record — in any table in 
the database — if you don’t have a phone number or don’t know an e-mail 
address, for example, it’s okay to leave those fields blank until you’ve obtained 
that information.

Fail to plan? Plan to fail
If you think carefully about your database, how you use your data, and what 
you need to know about your employees, customers, volunteers, donors, 
products, or projects — whatever you’re storing information about — you 
can plan

 ✓ How many tables you’ll need

 ✓ Which data will go into which table

 ✓ How you’ll use the tables together to get the reports you need
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15 Chapter 1: Access 2013 Basic Training

Of course, everyone forgets something, and plans change after a system 
has already been implemented. But don’t worry — Access isn’t so rigid that 
chaos will ensue if you begin building your tables and forget something (a 
field or two, an entire table). You can always add a field that you forgot (or 
that some bright spark just told you is needed) or add a new table after the 
fact. But planning ahead as thoroughly as possible is still essential.

 As part of thorough planning, sketch your planned database on paper, drawing 
a kind of flow chart with boxes for each table and lists of fields that you’ll have 
in each one. Draw arrows to show how they might be related — it’s sort of like 
drawing a simple family tree — and you’re well on your way to a well-planned, 
useful database.

Here’s a handy procedure to follow if you’re new to the process of planning a 
database:

 1. On paper or in a word-processing document, whichever is more 
comfortable, type the following:

 • A tentative name for your database

 • A list of the pieces of information you plan on getting from that 
database on a daily or regular basis

 2. Now, based on that information, create a new list of the actual details 
you could store:

  List every piece of information you can possibly think of about your 
customers, products, ideas, cases, books, works of art, students — 
whatever your database pertains to. Don’t be afraid to go overboard — 
you can always skip some of the items in the list if they don’t turn out to 
be things you really need to know (or can possibly find out) about each 
item in your database.

 3. Take the list of fields — that’s what all those pieces of information 
are — and start breaking them up into logical groups.

  How? Think about the fields and how they work together:

 • For example, if the database keeps track of a library of books, perhaps 
the title, publication date, publisher, ISBN (International Standard 
Book Number, which is unique for each book), price, and page 
count can be stored in one group, whereas author information, 
reviews, and lists of other titles by the same author or books on 
the same topic can be stored in another group. These groups 
become individual tables, creating your relational database of books.

 • Figure out what’s unique about each record. As stated in the previ-
ous point, you need a field that’s unique for each record. Although 
Access can create a unique value for you if no unique data exists 
for each record in your database, it’s often best to have such a 
field already in place, or to create such a field yourself. Customer 
numbers, student numbers, Social Security numbers, book ISBNs, 
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catalog numbers, serial numbers — anything that isn’t the same 
for any two records will do.

  With a big list of fields and some tentative groupings of those fields at 
the ready, and with an idea of which field is unique for each record, you 
can begin figuring out how to use the data.

 4. Make a list of ways you might use the data, including

 • Reports you’d like to create, including a list of which fields should 
be included for each report

 • Other ways you can use the data — labels for mailings, product 
labels, catalogue data, price lists, contact lists, and so on

 5. List all the places your data currently resides — on slips of paper in 
your pocket, on cards in a box, in another program (such as Excel), or 
maybe through a company that sells data for marketing purposes.

With this planning done, you’re ready to start building your database. The 
particulars of that process come later in this chapter and in subsequent 
chapters, so don’t jump in yet. Do pat yourself on the back, though, because 
if you’ve read this procedure and applied even some of it to your potential 
database, you’re way ahead of the game, and we’re confident you’ll make 
good use of all that Access has to offer.

Databases with user forms
When you’re planning your database, consider how the data will be entered:

 ✓ If you’ll be doing the data entry yourself, perhaps you’re comfort-
able working in a spreadsheet-like environment (known in Access as 
Datasheet view), where the table is a big grid. You fill it in row by row, 
and each row is a record.

  Figure 1-1 shows a table of customers in progress in Datasheet view. You 
decide: Is it easy to use, or can you picture yourself forgetting to move 
down a row and entering the wrong stuff in the wrong columns as you 
enter each record? As you can see, there are more fields than show in 
the window, so you’d be doing a lot of scrolling to the left and right to 
use this view.

 ✓ You may want to use a form (shown in Figure 1-2) instead. A form is a 
specialized interface for data entry, editing, and for viewing your data-
base one record at a time, if

 • Someone else will be handling data entry

 • Typing row after row of data into a big grid seems mind-numbing
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Figure 1-1: 
Datasheet 

view can 
be an easy 

environment 
for data 

entry. Or 
not.

 

The mind-numbing effect (and inherent increased margin for error) is espe-
cially likely when you have lots of fields in a database, and the user, if work-
ing in Datasheet view, has to move horizontally through the fields. A form 
like the one in Figure 1-2 puts the fields in a more pleasing format, making it 
easier to enter data into the fields and to see all the fields at once (or only 
those you want data entered into). 

You find out all about forms in Chapter 7. If your database is large enough 
that you require help doing the data entry, or if it’s going to grow over time, 
making an ongoing data-entry process likely, Access is the tool for you. The 
fact that it offers simple forms of data entry/editing is reason enough to make 
it your database application of choice.
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Figure 1-2: 
Here’s a 

simple form 
for entering 

new records 
or review-

ing existing 
ones.

 

Databases that require special reporting
Yet another reason to use Access is the ability it gives you to create custom-
ized reports quickly and easily. Some database programs, especially those 
designed for single-table databases (known as flat-file databases), have some 
canned reports built in, and that’s all you can do — just select a report from 
the list and run the same report that every other user of that software runs.

If you’re an Excel user, your reporting capabilities are far from easy or simple, 
and they’re not designed for use with large databases — they’re meant for 
spreadsheets and small, one-table lists. Furthermore, you have to dig much 
deeper into Excel’s tools to get at these reports. Access, on the other hand, is 
a database application, so reporting is a major, up-front feature.

An example? In Excel, to get a report that groups your data by one or more 
of the fields in your list, you have to sort the database first, using the field(s) 
to sort the data, and then you can create what’s known as a subtotal report. 
To create it, you use a dialog box that asks you about calculations you want 
to perform, where to place the results, and whether you’re basing a sort and/
or a subtotal on more than one field. The resulting report is not designed for 
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19 Chapter 1: Access 2013 Basic Training

printing, and you have to tinker with your spreadsheet pagination (through a 
specialized view of the spreadsheet) to control how the report prints out.

In Access? Just fire up the Report Wizard, and you can sort your data, choose 
how to group it, decide which pieces of data to include in the report, and 
pick a visual layout and color scheme, all in one simple, streamlined process. 
Without you doing anything, the report is ready for printing. Access is built 
for reporting — after all, it is a database application — and reports are one of 
the most (if not the most) important ways you’ll use and share your data.

Because reports are such an important part of Access, you can not only 
create them with minimum fuss but also customize them to create powerful 
documentation of your most important data:

 ✓ Build a quick, simple report that just spits out whatever is in your table 
in a tidy, easy-to-read format. (See Figure 1-3 for an example.)

 ✓ Create a customized report that you design step-by-step with the help of 
the Report Wizard. (See Figure 1-4.) The report shown in the figure has 
the customers sorted by their company name. These options were easily 
put to work with just a few clicks.

 

Figure 1-3: 
Ah, simplic-
ity. A quick 

report is just 
one click 

away.
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Figure 1-4: 
The Report 

Wizard cre-
ates more 
elaborate 

(but simple) 
reports, like 

this one.
 

 ✓ You can really roll up your sleeves and design a new report, or play with 
an existing one, adding all sorts of bells and whistles. Figure 1-5 shows 
this happening in Design view. Note that the report’s title (Customer 
Contact Report) is selected: It has a box around it and tiny handles on 
the corners and sides of the box, which means you can reformat the 
title, change the font, size, or color of the text, or even edit the words if a 
new title is needed.

So, you can create any kind of custom report in Access, using any or all of 
your database tables and any of the fields from those tables, and you can 
group fields and place them in any order you want:

 ✓ With the Report Wizard, you can choose from several preset layouts 
for your report, and you can customize all of it row by row, column by 
column.

 ✓ You can easily add and remove fields after creating the report, should 
you change your mind about what’s included in the report. If you want 
to place your personal stamp on every aspect of your report, you can 
use Design view to do the following:

 ✓ Add titles, instructional or descriptive text boxes, and graphics.

 ✓ Set up customized headers and footers to include any information you 
want to appear on all the report’s pages.
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Figure 1-5: 
Design 

view might 
look a little 

intimidating, 
but to really 

customize 
things, you’ll 

need it — 
and you 

might even 
enjoy it!

 

If all this sounds exciting, or at least interesting, then you’re really on the 
right track with Access. The need to create custom reports is a major reason 
to use Access; you can find out about all these reporting options in Chapters 
17 through 19. That’s right: This chapter plus three more — that’s four whole 
chapters — are devoted to reporting. It must be a big feature in Access!

What’s New in Access 2013?
For users of Access 2010, the upgrade to 2013 won’t seem like a big deal, other 
than the changes to the fonts used on the ribbons, the change to a white back-
ground for the ribbons, database tabs, and the All Access Objects panel on the 
left side of the workspace — but these are purely cosmetic changes.

There are some great new features, but you’re not gonna run smack into the 
learning curve that users of Access 2003 encountered upon upgrading to 2007 
or 2010.
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If you’re coming from 2003, the biggest changes are found in the interface. 
Gone are the familiar menus and toolbars of 2003 and prior versions, now 
replaced by a ribbon bar divided into tabs that take you to different versions 
of those old standbys. It’s a big change, and it takes some getting used to.

In this book, however, we’re going to assume you already got your feet wet 
with 2007 or 2010 and aren’t thrown by the interface anymore. We’re figur-
ing you upgraded to 2007 or 2010 or have played with one or both of them 
enough to feel comfortable diving into 2013.

New features
So what’s new in Access 2013? In the order you’re most likely to encounter 
them, here goes:

 ✓ The File tab and its dark red panel look very different; they replace the 
Office button and resulting menu in Access 2007, and the panel looks dif-
ferent than the one you may be used to from Access 2010. 

  Using the panel on the left (shown in Figure 1-6), you make your choices 
for opening new files, accessing recently used files, saving files, printing, 
and exiting the application (among other momentous decisions). It’s a 
lot like the File menu from Access 2003 in terms of what’s available; the 
File panel makes the commands and features that used to live on the File 
menu easily accessible. To get to it, just click the File tab.

  To go back to the Home tab (or whichever tab you were on before clicking 
the File tab), use the big left-pointing arrow at the top of the File panel.

 ✓ The biggest visible change, as we mentioned, is a new look and feel for 
the Access workspace. It’s a change seen throughout the whole Office 
2013 suite, of course, but we’re concerned only with Access in this 
book. How is the workspace different? It’s white, mostly. There’s no 
gray background to your menus or ribbons, and there are no gray bars 
separating the groups of tables, forms, and what not on the All Access 
Objects panel. In comparison to previous versions of Access, it’s a very 
flat-looking environment.
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Figure 1-6: 
The File 
tab and 

panel — 
hauntingly 
familiar to 
those who 
remember 

the File 
menu, and 
somewhat 

changed 
from Access 

2010.
 

Reach out with SharePoint
What the heck is SharePoint? You may be asking that, along with lots of other 
people who’ve been seeing the product name and hearing how it provides 
the ability to see and use your Access data from anywhere — using desktop 
applications, a web browser, or even your phone. Well, it’s a Microsoft soft-
ware product that does all that and more, helping you manage your docu-
ments and collaborate with coworkers via the company network. Simply 
click the Save and Publish command in the File tab’s panel (see Figure 1-7), 
and you’re on your way to publishing your database to SharePoint, which 
means you can access it from pretty much everywhere, including that beach 
in Maui. Of course, if you or your company don’t have a SharePoint server, 
you won’t be able to make use of this, and you don’t need to concern yourself 
with this section.
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Figure 1-7: 
The Save 
As com-

mand offers 
choices 

for . . . you 
guessed 

it . . . 
saving your 

database.
 

As shown in Figure 1-7, the Save As options include regular old Save Database 
As, to save your existing database with a new name or in some format other 
than as an Access database; and Save Object As, to save a table, form, query, 
or report with a new name. You can also choose from several Advanced 
options to save the database as a package (to distribute your Access applica-
tions) or as an executable file (a single file that when run by the recipient, 
opens a database application), to back up the database, and to use the afore-
mentioned SharePoint.

How Access Works and 
How You Work with It

When you look at all the applications in Microsoft Office — Word, Excel, 
PowerPoint, Outlook, and of course, Access — you’ll see some features that 
are consistent throughout the suite. There are big differences, too, and that’s 
where books like this one come in handy, helping you deal with what’s differ-
ent and not terribly obvious to a new user.
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Access has several features in common with the rest of the applications in 
the Microsoft Office suite. You’ll find the same buttons on several of the tabs, 
and the Quick Access toolbar (demonstrated in Chapter 2) appears in all the 
applications.

 If you already know how to open, save, and print in, say, Word, you’re probably 
ready to do the same things in Access without any difficulty.

To make sure you’re totally Access-ready, here’s a look at the basic procedures 
that can give you a solid foundation on which to build.

Opening Access
Access opens in any one of several ways. So, like a restaurant with a very 
comprehensive menu, some people will love all the choices, and others will 
say, “I can’t decide! There are just too many options to choose from!”

Now, you’ll run into situations in which one of the ways is the glaringly best 
choice — hands down, and that one will be the way to go. But what if you’ve 
never heard of it? You’ll be trying to find my phone number (I’m unlisted — 
ha!) so you can give me a piece of your mind. So to acquaint you with all your 
choices (so you’ll be ready for any situation), here are all the ways you can 
open Access:

 ✓ Windows 7 users can click the Start menu button (in the lower-left 
corner of the screen) and choose All Programs➪Microsoft Office 
2013➪Microsoft Access 2013.

 ✓ Windows 8 users can utilize any of several methods to start an applica-
tion — click the lower-left corner of the screen to display the Start icon, 
press the Windows key on the keyboard, or if you have a touchscreen, 
tap the Start button. Once the Start screen appears, tap the Access 
application tile.

  If you’ve recently used Access, you’ll see it in the list on the left side of the 
Start menu. Just choose Start➪Microsoft Access 2013, and Access opens.

 ✓ Double-click any existing Access database file on your Desktop or in a 
folder (as shown in Figure 1-8). Access opens automatically.

  Good news: Access 2013 will open database files you created with previous 
versions of Access, and should support whatever features are employed 
within those database files. All your tables should open properly, and 
reports, forms, and queries should all work fine, too.

 ✓ If some helpful person has added Access to the Quick Launch toolbar 
(on the Windows 7 taskbar), you can click the Access 2013 icon (it looks 
like an A on the cover of a book), and there you go. Access opens for 
you right then and there.
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Figure 1-8: 
Double-click 

an Access 
database 

file, and 
Access 

opens right 
up.

 

Selecting a starting point
So Access is open, and (assuming you opened it from the Start menu or from 
the Quick Launch portion of the Taskbar) you’re staring at the Access inter-
face. You may see features whose purposes elude you or that you don’t yet 
know how to use. Hey, don’t worry; that’s why you’re reading this book!

You can find out more about all the tabs and buttons, panels and menus, and 
all that fun stuff in Chapter 2. For now, just look at the ways Access offers you 
to get started with your database, be it an existing one that needs work or a 
new one you have all planned out and ready to go.

Opening an existing database
Well, this is the easy one. If a database already exists, you can open it by 
clicking the File tab (at the upper-left of the workspace) and choosing Open 
from the list of commands that appears. As shown in Figure 1-9, a panel 
opens, displaying the types of files you can open (just to the right of the long 
red File panel) and the databases you’ve most recently used. Click the word 
Recent in the list to the near left and then click the database in the Recent 
list, and it opens listing its current tables, queries, reports, and forms on the 
far-left side of the window.

When the database opens, you can open and view its various parts just by 
double-clicking them in that leftmost panel; whatever you open appears in 
the main, central part of the window. Figure 1-10 shows an example: a table, 
ready for editing.
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Figure 1-9: 
Pick your 
recently 

used data-
base from 

the Recent 
list on the 

right.
 

 

Figure 1-10: 
An existing 

table, ready 
for more 
records.

 

After you open a table, you can begin entering or editing records. You can 
read more about how that’s done in Chapter 6, which demonstrates the dif-
ferent ways to edit your data and tweak your tables’ setups. If you want to 
tinker with any existing queries, you can open these, too, just by clicking 
them in the list on the left side of the workspace. (For more information on 
queries, check out Chapters 11 and 12. You can do simple sorting and look 
for particular records with the skills you pick up in Chapters 9 and 11.)

Starting a new database from scratch
So you don’t have a database to open, eh? Well, don’t let that stop you. To 
start a new one, all you have to do is open Access, using any of the tech-
niques listed earlier in this chapter (except the one that starts Access by 
opening an existing database file, which you don’t have yet).
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 A database file holds all your database components. Everything associated 
with the data is part of the database, including

 ✓ All the tables that house your data

 ✓ Queries that help you search and use the data

 ✓ Reports that show what your data is and what it means

 ✓ Forms that allow people to view, enter, and edit data

After Access is open, click the New command in the File tab (if that’s not 
already the active command). From the resulting display, you can click the 
Blank Desktop Database button (shown in Figure 1-11) to get started.

Next, give your database a name (see the dialog box that appears in Figure 1-12), 
and click the Create button.

 The X in Figure 1-12’s caption represents a number — Access assigns consecu-
tive numbers to the default names, counting from any previously created 
databases. Figure 1-12 shows a 1 added to the filename.

If this is your absolute first database in a fresh installation of Access, the 
filename offered in this panel will be Database1. Note that you don’t need to 
type a file extension here; Access will add the correct one for you.

 

Figure 1-11: 
Click the 

Blank 
Desktop 

Database 
button in the 
New group.
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Figure 1-12: 
Name your 

database 
some-

thing that 
replaces 

the generic 
DatabaseX.

accdb.
 

 What is that little yellow folder in the dialog box where you named your 
new database? It allows you to choose a folder (other than the default My 
Documents folder if you’re a Windows 7 user, or the Documents folder in 
Windows 8) into which you can save your database. Click the folder icon after 
typing a name for your database, and then use the resulting File New Database 
dialog box to choose a location — an existing subfolder within My Documents, 
the Desktop, a network drive (if you’re on a network, say at your office), or 
your Office 365 Skydrive. The dialog box looks very familiar to anyone who’s 
used any Windows application, so this won’t be new territory for you.

At this point, with your new database open, you can begin entering records 
into your first table or begin naming your fields and setting them up. The 
field names go in the topmost row (the ID field is already created, by default 
in the new table), and the label Click to Add is atop the column with the 
active cell. If you choose to save your table now (right-click the Table1 tab 
and choose Save), you can name your table something more useful than 
Table1.

Starting with a template
Access provides templates (prepared files that work sort of like database 
cookie cutters) for your new database needs. You’ll find a set of template 
icons in the same New panel where we just chose a Blank Desktop Database. 
As shown in Figure 1-13, you can choose a template category by clicking any 
of the words under the Search for Online Templates search box, and search 
online for templates in that category.

Once the online search is complete (assuming you’re online at the time), a 
series of big buttons, one for each template found that matches your search, 
appears. Note that a larger list of categories — to be used if you want to 
search again for another category of templates — appears on the right.
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Figure 1-13: 
Click a 

template 
search word 

to search 
online for 

templates in 
that 

category.
 

As demonstrated in Figure 1-14, Employee category database templates are 
shown.

When you click any of the templates, the resulting display (shown in Figure 
1-15) describes the template so you can decide if you really want to use it.

Now What?
So you’ve got a new database started. What do you do now? You can leaf 
on over to Chapter 2, where you can find out more about all the tools that 
Access offers — which tools are onscreen almost all the time and which ones 
are specific to the way you chose to dig in and start that database.

In Chapter 3, you actually begin building a database, setting up tables and the 
fields that give them structure. And you figure out which tables you need to 
set up, putting that great plan you built in this chapter to work!
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Figure 1-14: 
View the 
results of 

your search 
for online 
database 

templates.
 

 

Figure 1-15: 
Is this 

database 
template 
right for 

you? If so, 
click Create 

and name 
it to get 
started.
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